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Service Technologies Corporation makes no representations or warranties with respect to the contents of this guide and disclaims any implied warranties of fitness for any particular purpose.  We reserve the right to revise this publication.  No part of this publication may be reproduced in any form without the prior written consent of Service Technologies Corporation.

Trademark Acknowledgments:  Platinum for DOS® is a registered trademark of E Software Corporation. Pay-Ware is a registered trademark of Service Technologies Corp.   Platinum is a registered trademark of Platinum Technologies Int’l Inc.  & Best Software Corp.  All other trademarks are acknowledged.

STC’s Windows System Manager - Overview

STC’s Windows System Manager is a simple, external Windows-based interface offering secure access to our Windows products.  System Admin handles setup & access for Users, Companies & Menus.  It operates from “outside” the DOS or Windows-based Accounting Package whose files it processes.  Key Benefits to users are as follows:

DOS-based Accounting System Users can put the powerful features of STC’s Pay-Ware & Utilities for Windows Programs to work with existing Systems.  No Accounting System upgrades are required!

Accessing STC Programs from “outside” the accounting package does not “add” to that system’s active User Count.  For User-intensive features such as Counter Sales terminals, this may reduce the user-license count (and maintenance fees) needed to run the system day to day.  Additional STC Users @$295 are significantly less costly.

Direct access from a smaller menu reduces the time & complexity needed to perform a specific task.  Users can “get in,” perform the desired activity and exit the job quickly without “clicking through” multiple menus

Network Users can use the STC System Manager to “repath” Pay-Ware payroll data files outside the accounting system drive.  This can allow “ironclad” network-level file access security for this sensitive data.

The System Manager Menu System is intuitively easy to use.  It is modeled after popular “Browser” formats with Program-Specific or Menu Group Categories shown down the left side and individual Menu Options on the right side.
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When installation is complete, the System Manager will install a new Pay-Ware option on the “Programs” section of the Windows “Start” Menu (see above).  It will also install (at user’s option) a Desktop Icon/Shortcut to the program.  The Program may be launched from either option.
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After being launched, the System Manager Login Window will appear requesting the User Name and Password.  Entering this information launches the “blue” STC System Manager shown above. 

System Configuration Requirements

The STC System Manager requires a computer with the following equipment:

Minimum Pentium 233 or higher CPU & 64Meg RAM - 8x CDROM drive 

Windows ’98 or later O/S 

Monitor capable of at least 800X600 display resolution.

Laser Printer is highly recommended.

Pre-Installation Checklist

1. If Installing this STC Windows Program to run ONLY from within the PFW by Best® Menu system (without installing the STC System Manager) STOP! See STC’s separate Installation Guide.

2. To install this STC Program including the STC Standalone System manager (for external program configuration & user access) follow the instructions in this guide. 

a. If access from BOTH PFW & STC System Menus is desired, the STC Program MUST be installed in the PFW Server & Client Directories.  PFW Administratative setup is required to properly handle Menu Item, User, & Company Access security under PFW.

b. If access is ONLY from the STC System Manager, the program may be installed on any drive/ directory.  Network Users must install the Program Files on a Network Drive.  Note that Client files must be installed on a local drive.  

Standalone installations MUST install Client files in a separate directory/folder from Program Files. 

3.  Due to the complexity of installation, it is recommended that an Authorized VAR or Consultant perform any STC Utility or Pay-Ware for Windows installation.

Installation Overview

STC Utilities for Windows installation procedure is a client/server installation. Any Windows-based programs should be closed and virus-detection programs disabled before installing.

Please read through the entire procedure before starting any Installation activities 

1. IF REQUIRED - Install Btrieve Workstation Edition. If your Workstation is not already configured with a Btrieve Workstation Engine or Pervasive 7 or .SQL Client, you MUST first install and configure the 6.15 Workstation Edition (6.15wse) included with this STC Windows product.   

2. Server/Program Files Installation – STC Utilities’ executable program files are installed from the CDROM to newly created subdirectory (X:\xxx\stc_util) on the network file server.  With PFW - Other PFW Resource/Menu files are updated and the STC Client Setup files are installed. 

3. Module User Setup – STC Utilities’ administrative functions (user access/security & Company Setups) are configured.  To run under PFW Menu, Menu access must be set up by the PFW System Administrator for existing and new users to ensure confidentiality.

4. The individual Client Workstation set-ups are made from the Server’s Client Files

 (Originating directory X:\xxx\stc_util\pwclient\setup.exe).

1. Btrieve 6.15  Workstation Edition Installation – IF REQUIRED

If your Workstation is not already configured with Platinum For Windows or a Btrieve Workstation Engine or Pervasive 7 or .SQL Client, you must first install and configure the 6.15 Workstation Edition (6.15wse) included with this STC Windows product.   You can easily determine this by reviewing the Windows Programs Menu (Start > Programs).

If either a “Btrieve Technologies Database” or a “Pervasive” Item appears on the Windows Programs Menu (see below) you may skip this Section and Go To Step 2 – Server Program File Installation.  Otherwise, continue with the following Procedure
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Begin this installation as follows – Be sure the CD is in the Drive

From the Windows Start Button, select Run and then Browse to the CD Drive.  Go to the “wse6.15” Folder.

Select the Setup Program in that folder so that the File Name/Path is X:\wse6.15\Setup.exe (below)
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Click OK and the installation program will begin
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The “normal” Install Shield windows will appear asking you to select the Installation location (Next) and the Name that will identify the program (Next).  We recommend just accepting the default information.
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After this information is entered/confirmed, clicking Next will start copying the program files to their locations.  When the ‘Finish” Window appears, click Finish (you may say “no” to skip the Read me File).  

[image: image44.png]SERVICE TECHNOLOGIES

CORPORATION




The following window should appear on your desktop.  If is doesn’t, you may launch it by clicking “Btrieve Technologies Database” on the Windows Program Menu.  Click on the Microkernal Setup Icon to properly configure the record manager.  Work from the top down through the list beginning with File Settings (see 2nd Box) and highlight each of the 6 parameters (in the 3rd Box) starting with “Open Files” and change it’s default values for the specified MKDE parameter values (125) shown below.  Don’t change any of the other settings.
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	 MKDE  Parameters

File Settings  (see 2nd box)  
    Open Files (see 3rd box)
    Handles

    Record Locks Per Client

    Index Balancing

    Create Files in Pre 6.x Format

     Logging of Selected Fields

Memory Resources (see 2nd box)
     Cache Allocation

Client System Transactions 

      Operation Bundle Limit

       Initiation Time Limit


	Value

Bottom Box

 125

 150

   75

 Off

 Off

 Off

 2048

 1000

10,000

Change Above Values Here




Do not adjust any settings besides those shown above.  Save the settings once all changes have been made.

This completes the Record Manager Setup.  You may now begin to install the Pay-Ware for Windows Programs (see next section). 

2.  Installation Procedure – Pay-Ware Network Server Files (Network Admin Rights required)

This step does not need to be run on the actual file server.  It is often best performed from a workstation.

· Identify the network Drive where Platinum system files are installed.

· Insert the STC CD-ROM into the drive and close it.  [Keep the Serial No. from the sleeve handy]

· Click the Start Menu & Select: “Run”.  Browse the CD Drive for the pay-ware folder 
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· In the pay-ware folder select the set-up.exe program.  Click OK to Run it, and the routine will launch.

Note that the Pay-Ware for Windows 170 Page User Manual (in Word (.doc) and Acrobat (.pdf) formats are available in the DOCUMENTATION Folder on the CD

The following Installation Window will appear-Read the Information and Proceed to the Next window to review STC License Agreement.
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	Hit “Yes” to “Accept” the 

terms of the Licensing Agreement

and to proceed with the installation

. 

(Note that you may go back to the 

previous Window or Exit the set up

program at any time.)




The Next window is used to select which version of the program you want to install.  

	
	The Demo Version may be installed without a Serial No.  Hit “Next” button when information is entered.




Standalone users have the option to install into the existing Platinum folder or another location. If not installing under “Platinum,” we recommend that you install to an STCPROG Directory/Folder on the desired drive.  

If you are installing "over" a "live" PFW system, all users should be out of PFW during the "server" install since the PFW Menu file will be updated during this process.  

The Demo is setup to prevent "overwriting" any current "live" Pay-Ware installation.  It specifically wll display an Error Message if it detects an existing Payware installation in the Installation path of the "Server" files.   Another directory path must be selected.  You may select "P:\Platinum\STCPROG" for example. If there is currently a Payware folder under Platinum.
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Hit “Next” to confirm the Drive and directory information.  If this destination Folder does not exist, you will be prompted automatically to create it (see above).  Click Yes.  Another Window will then appear allowing you to verify all information entered thus far-if correct click Next and the file copying process will begin.

	When all files are copied to the Server this window will appear.  Hit the “Finish” button to complete the Server installation.  

You may then be automatically prompted to run the Pay-Ware Client Install (see #3. below).

You may remove the CD from the Drive when this process is complete.


	


There is generally no need to reboot as a result of this install.  

PFW Users may then get back into PFW.
3.  Installation Procedure – STC System Administrative Set up 

 Skip this step if the Program is not being run from the PFW System Menu 

User & User Group Access/Setups - Once the STC Utilities system files are installed on the server, the  System Administrator should log on and enable the new options for the eligible user groups.

Crystal Viewer - STC Programs run on the workstation and reports can be output to Crystal Reports’ viewer or to Windows Laser Printers.  To view any report again (without re-running it) it must be “saved” (to the Desktop is easiest) and opened in Crystal. Reports may also be printed to Windows’ printers after they are displayed in the Viewer.  .    

Printer Setups should be reviewed to verify they will work with the new options.  STC Programs print directly through Windows.  Platinum/PFW–defined printer setups are not used.  Since Crystal is a graphical. page-based output interface designed for Laser printers, printing reports to Dot-Matrix printers will be significantly slower than under PFW and some formatting may be lost.  

4. Installation Procedure – STC Program Client Workstation Set Up
After all Pay-ware server/system setup is done, the individual Workstation setups are run. From the appropriate Workstation, go to Start>Run and Browse to the Server drive’s Payware Client Set-up Folder (originating directory path X:\xxx\payware\pwclient\setup.exe).  [Directory “xxx” would be STCPROG for the example from the previous page.]

The installation procedure for the first 3 windows is the same as section 1 (above) except that the destination location folder on window 3 should be pointed to the workstation’s local Client Drive & Folder (generally c:\pfw for PFW users).  

For stand-alone/Local use, any Folder/Directory on the Local Workstation hard drive (We recommend C:\STCCLIENT) may be specified except for the directory where the Program files are installed (X:\STCPROG in the above example).  If the directory does not exist, the program will prompt you to automatically create it.


When “Next” is clicked, the routine will then prompt whether to install the STC System Manager – Click Yes.

[image: image18.png]Que:

Pay-Were for Windows can be run outside of the Platinum Systerm Manager. Would you like to
install the STC Systern Manager and Deskiop loon now?

|





Users are then prompted to specify the appropriate Windows Program Menu Group where the Program will be “launched.”  Specifying the default will add a PFW Group and Menu Item.  This means that when Windows Start>Programs are clicked there will be a “Pay-Ware” option on that list of Programs.
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When Next is clicked, the verification window allows you to confirm the installation path for the Pay-ware client files.
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When Next is clicked, the installation will begin copying files from the “system/programs” folder down to the “client folder on the local drive.

Once the files have been copied to the local PFW drive, click “Finish” to complete the installation.   After all Client Workstations that will be running Pay-Ware are set up, software installation is complete.

5. Verify Installation
The final installation step is to inspect the Windows Programs Menu and the Desktop for the new STC Program & Icon.  Each of these should be double clicked to verify that it launches the Login Window shown in the Overview section of this document.  If so, the installation has been successfully completed.   

You must repeat this procedure for all Workstations accessing STC Programs.

6.  Check Out Pay-Ware's Many Powerful Features 

When the Client Installation is complete you may launch Pay-Ware from its desktop Icon (below right) and then Log In as USER1 (no password).  Without further setup, you will come up in the "Dog's World" Demo Company.  The current  processing period is Feb 2000 and there is a full year of 1999 data available to process reports against.  Be sure that the Pay-Ware Menu Group (not the HR-Ware Menu) is enabled (on top of the left side of the window) to see all options.    
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The Demo is a fully-functioning program but will only process in the "Dog's World" Demo Company.  Adding & Changing into another company will generate the following message when a Menu Option is launched.
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7. Setup Procedure – STC System Manager Configuration

The User Group Setup, Company Setup & User Setup functions can be performed using the "Admin" Logon.  You may also wish to enable access from the PFW System Menu.
Those familiar with PFW may want to log in as Admin (password MASTER) to see how additional Companies and Users may be setup (take care not to conflict with a "live" PFW system).  Bring up the Login Window.  Note that the Admin User CANNOT do any routine processing.  It is only used to setup 1)User Group Menu Item Security, 2)Users & 3)Companies.  
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	These functions are found by clicking the Admin button.

     User Group Setup

     Company Setup

     User Setup




STC System Manager Configuration - (continued)

 User Group Setup controls Menu Security allowing Administrators to customize Processing Menus by User Group.  The Menu Items visible to each User and their ability to process (or merely view the data available) on a Menu Item is determined by the User Group to which that User is assigned.  The “Default” user Group comes with the program.  The easiest way to load the Configuration Window is by double clicking the “Find Record” Lookup button (this is similar to the ALT I function in DOS) & then clicking on Default Group in the lookup window.  To change Menu Item security, you may alter the Default Group setup or create new “Payroll” Group(s).
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User Group Setup Window

After the window builds, the list of all Menu Items will appear with a Read & Write Column of checkboxes.  Each Menu Item that is checked “Write” will appear to every User assigned to the “Default” User Group.  They will be able to fully process all these items.   Menu Items checked “Read” will allow the User access to the information available on that Menu Item, but the user will not be allowed to change or process any of its data.  Items that are not checked will not appear at all on the User Menu.

Once the Default Group’s Menu is checked off, the change to the record must be “saved” by clicking the File>Save or the Diskette Icon (same as most windows programs),

	
Open New Record
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“Cloning” a User Group (or any record) is quickly done by selecting an existing record (Group), which is setup similarly to the record to be added.  Once the record is loaded, click the “Edit>Set As Default” Menu options and then the “New Record” (leftmost) Button.  Change the ID, Name and revise any other desired data.   Then “save” the newly named record.

STC System Manager Configuration - (continued)

Company Setup (accessed by clicking the Admin Menu) is the second Setup item to be configured.  There are no defaults setup for this menu item.  New processing companies may be setup from “scratch” or the STC System Manager can be configured to access data from an existing Accounting System.  The window allows a Company Key & Company Name to be setup in fields 1 & 2.  These can be the same or different than the Key(s) & Name(s) specified for the same data in the Accounting System.   The data fields, which get processed, depend entirely on the data paths entered in Fields 3 & 4.  To access data for an existing Platinum Company (OLDCO for example) you just set the Company data path in Field 3 to that location.  This feature can allow sensitive payroll data to be moved to a separate Network drive/directory for security reasons.

Lookups and record “cloning” work just like those in User Group Setup.   
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Company Setup Window

User Setup – After User Groups and Companies have been setup, Users may be assigned to them.  Clicking on the Admin Menu’s User Setup option loads the following configuration window. 
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User Setup Window

User IDs are entered in Field 1 and Password in Field 2 (leaving blank will allow user access without a password (hit Enter).  The user is assigned to the desired User Security Group and Processing Companies (see above) in Fields 3 & 4.  Note the “Find Record lookup on the “User Key” field at the top of the window allows quick retrieval of all users’ configuration.   Lookups and record “cloning” work as previously described.

When all Companies & Users have been setup, STC System Manager configuration is complete.       

With all Administrative Setup complete, Users may Login, select a Company and get familiar with Pay-Ware’s processing basics.

STC Programs – User Processing Basics - File Maintenance/Data Entry
Remember the following:

You must be logged in as a valid User and select a valid company to process anything in Pay-Ware for Windows.  We ship with only USER1 enabled.  Current PFD Users with other ID’s other than USER1 will have to be setup.  

Pay-Ware for Windows prints only through printers setup in Windows  [PFD Printer setups are not recognized].  If you cannot print properly from it, your windows printer setups are nonstandard and must be setup.  Laser-type printers are strongly recommended - Dot Matrix printers are not fully supported.

Windows Processing Basics
STC Programs processing windows are similar to those of most Windows Programs.  There is the familiar Blue Title Bar at the top Identifying the Window and its Max/Min/Max/Close boxes. 

The basic Menu Row for File, Edit, View & Help functions is also familiar and many tasks associated with those operations (such as Save, Delete, Cut, Paste, etc.) are similar to most Windows-based programs. 

  Note that “right clicking” the mouse will launch a Cut, Copy, Paste Menu (found under the Edit Option).  
Other tasks are more program specific.  For example the File Menu contains all activities associated with accessing a record and moving through the database (Get First/Last/Next/Previous Record & Find, Save or Delete Record). 

The row of “Operator Buttons below the Menu Row is more unique to STC Products.  They largely provide a shortcut to the actions associated with the Menu Items above. But they should be familiar to any user of a Windows-based Systems.  These click able buttons replicate the Platinum DOS version “Alt+” Key commands (Alt+A ,C, D, F, I, L, N for “add”, “change”, “delete”, “first”, “inquire”, “last”, “next” 

These “Buttons” do the following (Right to Left).  

New Record 
       Erase/Delete Record


         Save Record    Get 1st or Previous Record





   

Get Next or Last Record






 


   Find Existing Record Button (Similar to Alt+I)
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The Arrows & Double arrows allow users to “Step through” the available set of records frontward or backwards.  The Find Record Lookup Button allows a quick way to find a specific record without stepping through them via the Arrows.  Almost every field within a maintenance, entry, or parameter window has an associated lookup.

“Cloning” a record, allows users to quickly add a new item to the database, which is very similar to an existing item.  This is quickly done by loading an existing record, (which shares many parameters with the “new” one). Once the record is loaded, click the “Edit>Set As Default” Menu options and then the “New Record” Button.  Change the ID, Name and revise any other desired data.   Then “save” the newly named record.

STC Programs – User Processing Basics - Lookups

Lookups contain the available information for entry in the field.  Data to be entered in the field is selected from the lookup dialog box.  A Field’s lookup is almost always displayed by choosing/clicking the lookup button or pressing F9.   With certain lookups, you can scroll through the available lookup information.

	A.   Table or Field Lookups

These lookups appear in a Window as a “Magnifying Glass” Icon to the right side of a field.

Clicking the Icon will launch a small mult-Iine lookup window from which available information may be selected.  

     Table Lookups (“Find Record”) replace the PFD   

     Alt-I Inquiry and appear against a Yellow

     background (generally found at the top of a  

     parameter window)  & will show all available data   

     fields for a given record when it is clicked.  [This 

     will populate all data fields on the window].

     Field Lookups replace the PFD Alt-Z Inquiry &  

     show against a gray background and return only 

      the data to populate that data field 

 Include List lookups appear as a “Down Arrow” to the right of a field.  All available data options “drop down” when the arrow is clicked.
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	Calendar Lookups appear as desk calendar Icon on Date-Related fields and launch a calendar with the current date


STC Programs – User Processing Basics - Running Reports & Listings

Reports & Listings are a key component of your STC Program.  This Program generates all its reports using Seagate® Software’s popular Crystal® Reports program.  Unless specified otherwise on the “Routing” Tab of a Report’s Setup Parameters, the report will automatically be displayed On-Screen in the Crystal Viewer when is completed.  From the Viewer, the report may be printed to Windows Printer, printed to a file or its data exported to a Spreadsheet.   Any report’s “Routing” parameters may specify output directly to a printer.  In this case, the report will not appear on-screen in the viewer. 

Note that Crystal is a graphical, page-based printing program intended for Laser-type printers.  While it generally will output to Dot-matrix printers, Users may encounter long report printing times and formatting glitches.  We strongly recommend using Laser-type printers if at all possible. 

It is easy to define and save standard report parameters against which Reports or Listings are routinely run.  Any Report (or Listing) which has had a parameter configuration “saved” will appear in a View List (below).  

In reports where no parameters have been saved, the View List will be empty.  

A “pre-saved” report can quickly be run by highlighting it and 1) clicking its Name in the box or 2) clicking the Process button below the list.  If the pre-saved format includes data fields that need to be filled in (for a range of Dates, for example) the Parameter setup window will automatically load and the cursor will stop in the first Field where an entry is needed.  This field will show a “Pencil” icon to the right. An entry must be made in all empty fields (clearing every Icon) before the report will process.

Note that pre-saved parameters include the output location for the report (e.g. a specific Windows printer), 

Setup Parameters for any saved report may then be viewed and Modified by clicking the Edit Button.  If changes are made, the modified configuration may then be resaved under the old name (or saved under a new name-which creates an additional report on the View List) by clicking the Save Button.  The Report is removed from the View List via the Delete Button.
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STC Programs – User Processing Basics - Running Reports & Listings (cont’d)

Choosing the New or Edit buttons will load the Report Parameter Setup Window where Reports are defined and (optionally) saved.  

Clicking “New” will load a “blank” parameter Setup window (no data entries in any field).

Clicking “Edit” on a highlighted report in the View List will load all its setup parameters.

The typical Setup procedure goes as follows:

Parameters Tab

1. Sort Order for the report is selected in the top Field

2. One or more Ranges of available Data items to be included in the Report are specified.

3. Often a Range of Dates parameter is specified for the Report

Output Format (Detail, Summary, inclusion of Totals or Page-breaks, etc.) items are specified.

4. Note the “Pencil” Icon (below left) setup on the first Date Field.  It is used when report parameters are setup to “require” an entry in specific field.   The “Pencil may be removed from a field by 

	Clicking the Pencil Icon (top of window) while the cursor is parked on a field and “saving” that Report Parameter will prompt for an entry in that field next time the saved Report is processed.  Entering valid data and hitting the <Enter> Key clears the “placeholder” and launches the report.  Clicking the Pencil Icon again will remove the placeholder/prompt.
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Tab 1- Parameters
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Tab 2 - Routing


Routing Tab (see above right) specifies where the report will be “sent”.  All reports are defaulted to the Crystal Reports Viewer but the setup may be sent directly to any Windows printer.  You may require this Tab to appear before any saved report is processed by checking the “Show this Tab before processing” box at the bottom.  This makes it simple for the user to route a given report to the desired printer or to the viewer. 

Remember that Dot-Matrix Printers are not optimizable for Crystal output.

Pay-Ware( Demo Tour Guide
If you want to test Pay-Ware’s  features, Select GLSDEM - Demonstration Inc. to review Report or D/R/A setups. A full year of 1999 data is available.  The current year is set to 2000.

This Guide highlights many of the features available in the Pay-Ware payroll system and provides the navigation paths to see and “test drive” them.  These features make Payroll Processing & Reporting faster and easier than ever while offering more precision and flexibility.  This Demo is user-directed and provides live, “hands on” access to try out all areas of the program (there is no “self-running” track).   

(Let’s Get Started by reviewing Pay-Ware’s many Data Entry features. 

Select (>) Document Entry Forms ,  and  (>) Enter Time Cards.  

In the first field (Emp #) of the Time Card Entry Screen, you can sample our “Hot Window”  feature by activating the Lookup Window < F9> to find the Employee Record of your first time card.  OOPS!, suppose it’s a new employee (there’s no record defined).  No Problem. . . with the Lookup Window still up, press the <File Maintenance > Button.  The fully functional Employee Master Screen will pop up, and you can enter all of the new employee’s data from here--instead of backing out to File Maintenance.  Just save the employee addition and close the window back to the T/C Entry screen.  Now that Record can be selected from the Lookup Window and you’re ready to input their time.  This same “Hot Window” procedure works in the other entry Fields (Position Codes, Attendance Codes & Departments) as well as from the Correct Time Cards Screen.

While you’re here, note that the cursor sometimes skips one or more fields when you press Enter. This is Pay-Ware’s user-defined TAB function, which allows automatic acceptance of Default information without having to “Enter” on every field.  Default data may be overridden by simply “arrowing” (() to that field.  The tab positions may be temporarily changed (i.e. This session only) to minimize keystrokes by clicking the “<>” (Next/Prior Record Buttons) while the cursor is in a particular column.  Clicking the Save button will keep these tab settings every time the screen comes up.

You may also want to check out the Attendance Codes, which Pay-Ware uses to track categories of Earnings (similar to Earnings Types)  and Position Codes (utilized in Reporting  and in the Automatic Calculation of Overtime).  There are virtually an UNLIMITED number of alphanumeric Codes available for both of them (Pressing <F9> on either of these fields displays the available Codes). The Shift (S) column allows automatic default wage adjustments by work shift (1,2,3).  All these features simplify Data Entry and significantly enhance tracking/reporting of Earnings.  You should also notice that as the screen fills with Time Cards, it Automatically Scrolls Up, and maintains a Running Total of Pay Units at the bottom.  Before You Leave Data Entry, Enter 4 or 5 Time Cards For Processing (be sure they are within the Pay Period Information Date Range displayed in the lower right-hand corner of the Screen).
[image: image36.wmf]While still in Document entry, let’s go to the Computed Edit to see a couple exciting processing features.  First is the much-requested Mid-Cycle “Emergency” Single Check Generation Feature.   It allows immediate processing of any single employee check in a batch of entered Time Cards.  It is activated via selection on the Parameter Screen.  Try it out by selecting one of the available time cards and processing it.  You will also notice the Computed Edit itself has been enhanced to automatically generate the Preliminary Payroll Register Totals by State for all Error-Free Entries  (after it prints a list of all Warnings & Errors).   Now run a Computed Edit on all your time cards. 












The next stop after processing a valid Computed Edit is Printing Checks.  Pay-Ware will Print on either 11” (3 panel) or on 7” (2 panel) check/voucher stock with full earnings detail.  Also note the option to Print Employee’s Remaining Vacation &  Sick Pay/Disability on pay stubs .   Print out some 7” checks (on plain paper, of course), by going to System Configuration/Application Setup/Tab 4, Print Checks and specifying Seven Inch Checks (don’t forget to save the record).  Then Return to Computed Edit, Rerun it, and then Run the Print Check Routine.

(Let’s move from Document Entry to the simple Void Check feature (on the Utilities Menu). 

 
A Lookup Window in the Check Date field allows selection of any previously posted check (check number and date may also be manually keyed in).  Press <Process> and the Void is completed.

(It’s time to see some new File Maintenance Features

The Employee Master has seven tabs and two buttons with information. To see them, pull up the first employee record by clicking on the fourth button from the left. Press the fourth button from the right to view a complete History of everything that has been changed on the Employee’s record along with the date it was changed and by whom.  Close that window and go to Tab 7 to see the multi-line entry for D/R/A Plans and direct deposit bank information for the Employee. Tab 4 has dependent information (including whether the dependent is covered by any benefit plan).  Tab 6 shows the 5 user-defined “Miscellaneous” information fields that you can define for your own purposes (in System Configuration>Process Defaults).  These fields can be dates, numbers or characters.  Demo Company uses them to track Office Keys, Pagers and Company Credit Cards issued to Employees

Let’s jump to Cafeteria Plans (4th item on the File Maintenance Menu) to see how Pay-Ware handles both Employee and Employer Contributions to these complex and popular D/R/A Plans.   Both Employee & Employer contributions may be set up as Flat Dollars, Dollars per Pay Unit or Percentages of Pay (see Help Screens).  Additionally, caps (maximums) on Total Dollars, Number of Hours and/or Percentages may be entered for both Employee and Employer portions.  

Let’s check how this works by reviewing the setup for Demo Company’s 401k Plan—select code R01.  As you read down through the Data Fields, note that: 1) this Plan will be reported on participating Employees W-2 Forms in box 13D 2) any Year End Balances will be Rolled Forward to the following year; and that 3) the Reduction will be taken Every Pay Period-(Frequency 9).  Also note that the Employee Contribution will be a Percentage (%) of Gross Pay but the amount is blank.  Amounts/Rates are Setup individually on Tab 7 of each Employee’s Master File.   Please, notice that the Employee Contribution may be Capped at the Government Maximum.  Tab 3 has the  Employer Match.  It is Setup at 50% of the Employee Contribution and will Cap out at 3% of Employees Gross Wages.  Finally, note on Tab 2 that the Plan will decrease the Federal & State Income Tax Wage Bases (Yes answers) but not affect any other Wage Bases.

[image: image37.wmf](Enhanced Report Generation Capability is one of Pay-Ware’s strongest features.  You can select from an array of predefined reports, or modify them by adding or changing the order of the data fields, defining the sort sequence, and/or specifying which fields you wish to utilize to restrict the information on the report. 

(For Example, go to Quarterly Reports where Quarterly Reports are predefined and recreate the entire Government form-READY TO SEND. 

 
One key thing to notice is that you have a Choice of Quarters and Years.  All Historical Quarterly data  is available for the years that you have been using Pay-Ware.   

(Other information-laden items on the Reports Menu are the Employee Balance Totals & Payroll Register. These Reports are completely user-defined. 

Employee Balance Reports may be created for any Month, Quarter or Year (primarily for individual employees).

Payroll Register Totals Reports offer reporting on over 80 information items (detailing Earnings/ Wages, all Tax Withholdings, D/R/A’s & Employee Data).  These may be easily generated for any Date Range and/or Employee Range and sorted by Employee, State , Department & Payroll Date.   You may select either detail or summary.  There are sample reports for 401K  and wages/tax summary.

Other Pay-Ware features that facilitate speed and accuracy and can greatly automate Data Processing are Suppressible Pay Rate Display  (for confidentiality), Automatic Overtime Calculation and Earned Income Credit (EIC) processing as well as Time Card File Import capability.

This Completes Your Tour of Pay-Ware’s highlights. 

Please feel free to test out all its features.  Add some new Employee Information, Process an edit, Void a check, Print a 7” check, Define and Run some especially useful reports on the 1999 workforce, Setup and Process an Edit with Automatic Overtime... or any other feature your business might use 

TROUBLESHOOTING Common Installation Issues

CRVIEWER Failed to Self-Register

The Crystal Viewer is dependent on certain files matching up.  They vary by operating system.  The newer windows releases install without incident. 

 If you get an error on a Windows 95 workstation, copy the files from the server’s  platinum\payware\win95 directory to the c:\windows\system directory and reinstall the Pay-Ware client.

If you get an error on a Windows 200 or NT4 workstation, copy the files from the server’s platinum\payware\winnt directory to the c:\winnt\system32 directory and reinstall the Pay-Ware client.

Comcat.dll failed to self-register

The solution varies depending on operating system.  On a Windows 95 or 98 workstation, rename the existing comcat .dll in the c:\windows\system directory to comcat.old.  On a Windows NT workstation, rename the existing file in the c:\winnt\system32 directory to comcat.old.  In either case, then rerun the Pay-Ware client.  The correct version of Comcat.dll will be copied in and registered.

(Comcat.dll – 22kb – 6-11-1999).

ACBTRV32.OCX failed to self-register

This message is caused by a dependency issue with file WBTRV32.DLL which goes in the windows\system or winnt\system32 directory depending on the Windows version being run.  It should be a 42K file.  The correct version should be in the pvsw\bin directory on each workstation and can just be copied into the correct directory.   

Error 163 updating files

Pay-Ware requires the environmental variable of cobsw to be set to –f.  

In the older operating systems that utilize autoexec.bat during bootup, edit this file and insert this statement first in that file:


Set cobsw=-f

On Windows 2000 or NT4 this is entered from the Control Panel, System, Advanced, Environment, New—then in the Variable box enter cobsw and in the Value box enter -f

You will need to reboot the workstation for this change to take effect.

Dr. Watson Errors for Webcheck or Loadwc

Go to C:\WinNT\System32 and check Webcheck.dll file should be 269kb dated 8-16-1999 – if you do not have this version you can copy newer version in and reboot and error should go away.  

This is a Microsoft file and should be updated with Version 5 of Internet Explorer.

Record Manager Error – Status 12 File Not Found – File may need to be initialized.

If the installation fails to auto-initialize any new data files-you may see the above error message.

Files are initialized from the Utilities Menu - select Initialize Data Files.  Click Yes ONCE when the below left Warning appears.  Enter Yes and the file list appears-then scroll down to the appropriate file and highlight it.  The below right warning will appear confirming the file name-click Yes to initialize that data file.
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